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FMEA:N JA RCM:N RAJAPINTA

Laitteiden vika- ja vaikutusanalyysissa (FMEA) kaydaan lapi ensimmaiset nelja (1.-4.) RCM:n seitse-
masta vaiheesta. FMEA-analyysia voidaan laajentaa ottamalla mukaan vikojen kriittisyyden (C) arvi-
ointi (5.), jolloin analyysissa vastataan jo viiteen RCM-analyysissa esitettyyn kysymykseen. FMECA-
analyysi auttaa edetessaan muodostamaan nakemyksen vikamuotojen ja toiminnallisten vikojen vali-
sista syy-seuraus suhteista. FMECA-analyysin lopputuotoksena on muodostunut listaus analysoitavan
kohteen tunnistetuista vikamuodoista (vioittumistavoista) ja niiden aiheuttajista. Taman lisaksi tunnis-
tetut vikamuodot on arvioitu niiden eri jarjestelmatasoille aiheuttamien vaikutusten suhteen. Kriitti-
simmille FMECA-analyysissa tunnistetuille vikamuodoille pyritaan RCM:n kahdessa viimeisessa vaihees-
sa (6.-7.) etsimaan tehokkaimmat toimintamallit vikamuodon estamiseksi tai siita aiheutuvien seura-
usten lieventamiseksi. FME(C)A on hyva menetelma vikojen ja vaikutusten arviointiin jo sellaisenaan.
Lisaksi se toimii hyvana pohjana mahdollisesti myohemmin suoritettavaa RCM-analyysia varten. Alla
olevassa taulukossa (Taulukko 1) on esitetty perinteiset seitseman kysymysta, joihin RCM-analyysissa
pyritaan vastaamaan.

o gk~

7.

Mitk& ovat kohteen toiminnot ja suorituskykystandardit sen tamanhetkisessa toimintaymparistéssa?

Mita tapahtuu, kun kohde rikkoontuu (mitka toiminnot jaavat tapahtumatta)?

Mika aiheuttaa kunkin kohteen toiminnon puuttumisen / vajaatoiminnan?

Mité tapahtuu kunkin vikaantumisen yhteydessa?

Mit& vahinkoja kukin vikaantuminen aiheuttaa?

Mita voidaan tehda kunkin vikaantumismallin havaitsemiseksi riittdvan ajoissa tai vikaantumisen estami-
seksi?

Mité tehdaan, jos sopivaa ennakoivaa toimenpidetté ei [6ydy?

Taulukko 1: RCM-analyysin seitseman vaihetta

Toimintaohjeen tulevissa kappaleissa on pyritty antamaan ohjeita FME(C)A- ja RCM-analyysin kulusta
nykyisella ELMAS-ohjelmistoversiolla (v4.3.43). Alla olevaan listaan on maaritetty FME(C)A:ssa ja
RCM:ssa yleisesti kaytettyja vikaantumiseen liittyvia termeja:

toimintoa halutulla suorituskykytasolla (SFS IEC 50/191).

Vika (Fault) on kohteen tila, joka seuraa vikaantumisesta.

Oirehtiva vika (Potential failure) on havainnoitavissa oleva tila, joka osoittaa muutoksen ta-
pahtuneen kohti toiminnallista vikaantumista.

Vian syylla (Failure cause) tarkoitetaan vian alkuperaista syyta eli vikaantumiseen johtaneen
prosessin tai tapahtumaketjun aiheuttajaa.

Vikamuodolla (Failure mode) ymmarretaan vian ilmenemismuotoa eli sita, kuinka vika on ha-
vaittavissa. Kasitteelle vikamuoto yksi hyva vastike on myos vikaantumistapa.

Vian vaikutus (Failure effect) tarkoittaa sita valitonta vaikutusta, jonka vikamuoto saa ai-
kaan. Toisin sanoen vastaa kysymykseen mita tapahtuu vikamuodon myota.

Toiminnallinen vikaantuminen (Functional failure) on kohteen kykeneméttémyys toteuttaa
Vian seuraus (Failure consequence) tarkoittaa sita seurausvaikutusta, joka kyseisesté vikaan-
tumisesta aiheutuu. Vastaa siis kysymykseen mita seurauksia vialla on. Yleensa vikaantuminen
arvioidaan talous-, turvallisuus ja ymp'&iristéseurausten suhteen.

toimintaymparistossaan. Usein toimintoon lntetaan myo0s suorituskykyrajat, joita kohteelta
vaaditaan. Kohteella voi olla useita tehtavia, jotka jaetaan paa- ja sivutoiminnoiksi.
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ELMAS FMEA-RCM analyysi

Analyysin aloittaminen

FMEA-RCM analyysi aloitetaan ELMASissa luomalla ELMAS asetuksista (Tools->Options->Model->Model
Types->Add new tab type) uusia projektivalilehtityyppeja (kts. Kuva 7). Alla olevaan esimerkkipro-
jektiin (Kuva 1) on luotu uudet valilehdet tarkasteltavan osajarjestelman laitehierarkialle (Device
hierarchy) ja toiminnoille (Function hierarchy).

Dptions
Personal [ 2-Level Process Diagram ‘ Device hierarchy Function hierarchy ]
Model Model Types Fault Tree | Cause Tree | Cause-Consequence Tree Block Diagram ]
Modes Model Types
FMEA Data key Graph type
Expense Types Tree Top-Down Tree

Conseq Left-Right Tree
Other Block Block Diagram
Dynamic Sub block Block Diagram

4= Add new model type = Remove selected model types
Tab Types
Tab type title

Fault Tree

Cause Tree
Cause-Consequence Tree
Block Diagram

2+ evel Process Diagram
Device hierarchy
Function hierarchy

4= Add new tab type J = Remove selected tab types
Restore Default Model Options
43¢ Restore defaults
o OK J M Cancel & Help

Kuva 1: Uusien projektivalilehtien luominen

Kohteen valinta ja rajaus

Tehokkaan RCM-analyysin vaatima syvyys voi jaada saavuttamatta, mikali tarkastelun kohteeksi vali-
taan liian laaja kokonaisuus. Suositeltavaa olisi, etta analyysin kohteeksi valitaan jokin suuremmasta

nalla on suurin mahdollinen merkitys koko kohteen turvallisen toiminnan kannalta.

Hyva tapa analyysin kohteen valintaa helpottamaan on luoda tutkittavasta kohteesta (esim. tuotanto-
linjasta) yksi- tai kaksitasoinen lohkokaaviomalli kuvaamaan osaprosessien, jarjestelmien ja laitteisto-
jen valisia suhteita tuotantolinjalla (Kuvat 2 ja 3). Lohkokaaviomallin solmut on maaritetty niiden

tannukset, jolloin osaprosessit voidaan laittaa jarjestykseen myos niiden aiheuttamien kustannusriski-
en suhteen. Simulointituloksia voidaan haluttaessa kayttaa yhtena analyysikohteen valinnan mene-
telmana.
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RAL1_RAVO
Raaka-aineen
vastaanotto

\ RAL1_LAVO RAL1_LAS

Lisa-aineen Lisa-aineen

vastaanotto o3 Slirto

RAL1_S
! Raaka-aineen

ja lisi-aineen .
. sekoitus ‘A

4

Kuva 2: Raaka-ainelinjan lohkokaaviomalli

\ RAL1_RAS_P

Raaka-aineen
sirron
putkistot

Kuva 3: Raaka-aineen siirron tarkempi lohkokaaviomalli

Yksi tarkeista analyysin kohteen valintaan vaikuttavista tekijoita on investoinnin takaisinmaksukyky,
eli voidaanko analyysiin kaytetylla panoksella ja sen aikana tehdyilla paatoksilla oleellisesti parantaa
jarjestelman tuotantokykya, kayttovarmuutta tai laatuun vaikuttavia tekijoita. Ainoastaan turvalli-
tehtaessa. Analyysiin valitun kohteen tarkemmat rajat maaritetaan seuraavan vaiheen laitehierarkki-
seen puumalliin.

Laitehierarkkisen puun mallintaminen

Analyysin kohteen valinnan jalkeen luodaan tutkittavasta osajarjestelmasta sen laitehierarkkinen
puumalli valitsemalla Device hierarchy projektivalilehtityypiksi (kts. Kuva 4). Taman jalkeen paina-
malla Create new graph tab -nappia luodaan projektin laitehierarkian ensimmainen solmu, joka ku-
vaa laitehierarkian ylinta tasoa (esim. osajarjestelma). Laitehierarkiamallin on tarkoitus olla mahdol-
lisimman visuaalinen kuvaus tarkasteltavasta kohteesta, joka osoittaa kohteen rajat analyysiin osallis-
tuville ja myohemmin sita tarkasteleville henkiloille. Tama nopeuttaa projektiin osallistuvien kykya
hahmottaa tarkasteltava kohde ilman epatietoisuutta siita, mista osista analyysiin tietoa kaivataan.
Taman lisaksi laitehierarkkista mallia voidaan hyodyntaa myohemmin tarkasteltavan kohteen kaytto-
varmuustarkasteluissa.
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=[EL11A5 4 RAMoptim Dynamic

File Edit Tools Network Help

Process: RAL1 Raska-anelinja m ame

General Edit node

Edit open graph tabs Relations

Tabs Failure
Process: RAL1 Raska-ainelija Repar

Line Description:

@
@

Notes:

Add attachment: | (@) [ o
o 0K ¥ cancel @ Help

sa kaytettyja laitepaikkatunnuksia tai vastaavia tunnuksia, joilla kohteita kyetaan tunnistamaan.
Muuttamalla ID vastaamaan kunnossapitotietojarjestelman tunnuksia voidaan vika-, korjausaika- ja
huoltohistoria siirtaa solmuille automaattisesti kayttamalla ELMASin Excel-siirtotyokalua. Alla olevaan
solmun editorin kuvaan (Kuva 5) on laitteen nimeamisen lisaksi muutettu myos solmun ID vastaamaan
yrityksen tietojarjestelmissa kaytettya tunnusta kohteesta (kuvitteellinen).

Edit node: Device#1 Pumppu
General Edit node
Type

D [Device1 |
Relations
Failure MName: ||Pumppu ||
Repair
Line Description:
Risks
Maintenance
FMEA Notes:
Dynamic

Add attachment: @3 Ed B
« OK I # cancel ‘ &) Help

Kuva 5: Solmun editori

Laitehierarkiapuu rakentuu halutusta maarasta eri tasoja, joista alimman tason tulisi kuvata tarkas-
teltavan kohteen huollettavaa tasoa (suositeltu) eli tasoa, jonne vikamuodot kohdistuvat. Usein huol-
lettavaksi tasoksi sovitaan osa/komponenttitaso. Yleensa ollaan viela kiinnostuneita eri vikamuodois-
ta, joita osilla/komponenteilla esiintyy, jolloin osille/komponenteille luodaan viela tarkempi vika-
muototaso. Esimerkkiprojektin laitehierarkkinen puumalli on nahtavilla alla olevassa kuvassa (Kuva 6).
Laitehierarkian kolmannelle tasolle on sijoitettu osajarjestelman laitteiden komponentit, jotka niille
ominaisten loogisten ehtojen perusteella muodostavat eri laitteita. Laitehierarkkinen puu voidaan
rakentaa esim. seuraavista tasoista:
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- Osajarjestelma (Subsystem)
- Laite (Device) > muutettu ID (Device#)
- Osa/komponentti (Component) - muutettu ID (Comp#)

OR —
[ | | | ]
Device# 1 Device# 2 Device#3 Device#4 Device#5

Pumppu Kiayttdmoottor Kytkin ta Ohjauslogiikka
i ja
I T OR = T | OR + OR + OR |+ ORI+
Comp#1.1 Comp#1.2 Comp#1.3 Comp#1.4 Comp#1.5
Juoksupyora Imu- ja Laakerit Akse b Tiwwisteet
painepuolen
putkisto

Kuva 6: Laitehierarkkinen puumalli (vikamuotoja ei madaritetty)

Puun rakentaminen taman vaiheen tasolle voidaan olettaa olevan hyvin yksinkertaista. Usein taman
vaiheen laitehierarkkinen malli voidaan rakentaa yrityksen tietojarjestelmissa kaytetyn laitehierarki-
an pohjalta. RCM-analyysin ensimmainen askel, jossa pohjustetaan analyysin kohde ja rajat, tulee
taytetyksi edella suoritettujen toimenpiteiden myota.

Mitka ovat kohteen toiminnot ja suorituskykystandardit sen tamanhetkisessa toi-
mintaymparistossa?

Toimintohierarkkisen puun mallintaminen

Toimintohierarkkisessa mallissa voidaan kuvata tutkittavan jarjestelman toimintojen lisaksi sen lait-
teiden toiminnot. Paatos kuvattavasta toiminnallisesta tasosta tehdaan analyysikohtaisesti riippuen
analysoitavan kohteen laajuudesta ja halutun lopputuloksen tarkkuudesta. Laajoissa kohteissa laittei-
den toimintojen kuvaaminen toimintohierarkkisessa mallissa kasvattaa merkittavasti mallissa olevien
solmujen ja tasojen maaraa. Analysoitavan kohteen laitteiden toimintojen kuvaus voidaan haluttaessa
sijoittaa laitteita kuvaavien solmujen editoreiden kuvauskenttiin laitehierarkkiseen malliin, jolloin
valtytaan luomasta liilan monitasoista mallia toimintohierarkkiseen malliin. Toimintohierarkkisen mal-
lin tasojen tarpeellisuus tulee miettia tapauskohtaisesti suoritettavan analyysin tarpeen mukaiseksi.

Toimintohierarkkisen puun mallintaminen aloitetaan valitsemalla uudeksi projektivdililehdeksi Functi-
on hierarchy -tyyppinen valilehti projektin aloitusnakymasta (kts. Kuva 7). Valitun toimintotason paa-
ja sivutoimintojen maarittaminen suoritetaan jarjestelmaa, osajarjestelmia tai laitteita kuvaavien
solmujen alle toimintohierarkiamalliin. Toimintojen arvioinnissa tulee huomioida myo6s toimintoympa-
risto, jossa tarkasteltavan kohteen on tarkoitus toimia. Eri jarjestelmaosia kuvaavien solmujen ID:t
tulee nimeta toimintohierarkiamalliin uudella nimella laitehierarkiamallissa kaytettyyn verrattuna.
Nimeamalla ID:t solmutyypin perusteella (Function - F#) helpotetaan projektin eri mallien simuloin-
titulosten ja erilaisten projektiraporttien tarkastelua. Edella mainittua ID:n nimeamista solmutyypin
mukaan tullaan kayttamaan eri mallitasoja luotaessa esimerkkiprojektin edetessa.
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RALL

RALL RAVO
RALLLAVO
RALLLAS
RALLRAS  Raal
RALLS Raal
RALLRAS_P) Pum
RALLRAS P Raal

Graph tab type

Edit node: 1
General | Edit node
Toe
caopangrapn avs e | [

= eaire Name: [Pumppaussarjesteima

Process: RAL1 Raaka-sinelinja Repair

Device hierarchy: DH Pumppausiarjestema e Desaiption:
Risks.
Vs
-

Add attachment: | | &2 [ =
[l o] G (mee](Eoe]

Kuva 7: Toimintohierarkkisen puun mallintamisen aloitus projektin aloitusnakymassa (ID muutettu)

Esimerkkiprojektissa toimintotasoksi (taso 2) on valittu osajarjestelman (Subsystem) toiminnot. Sol-
mun editorin nimi- tai kuvauskenttaan on suositeltavaa lisata suorituskykytasot, joita toiminnoilta
edellytetaan nykyisissa toimintaolosuhteissa. Esimerkkiprojektissa tarkasteltavalle osajarjestelmalle
tarkasteltavan kohteen toiminnot voidaan maarittaa myos laitesolmujen (Device) alle. Kuvassa 9 on
nakyma mallista, jossa toiminnot on viety tarkemmalle tasolle.

F#1 F#2

Pumpata P{sﬁyttiﬁ ja
Kmpﬁrist&'lle aloittaa
aitallista pumppaus
iai | ohjauskaskystd

Kuva 8: Toimintohierarkkinen malli (toiminnot maaritetty osajarjestelmalle)

T I 1ORI= T T \
Device#1FH Device#2 FH Device#3 FH Device#4 FH Device#5 FH
Kiyttdmoottor Kytkin Taajuusmuutta | Ohjauslogiikka
i ja
] | i ]
F#1.1 F#1.2 F#2.1 F#3.1 F#4.1 F#5.1
Muodostaa Muodostaa Synnyttii Vilittds Siitelee ©Ohjaa pumpun
haluttu haluttu pumpun momentin moottorin kdyntia
tilavuusvirta nostokorkeus tarvitseman kdyttdmoottori | pyorimisnopeu
momentin Ita pumpun tta
akselille il bl |

Kuva 9: Toimintohierarkkinen malli (toiminnot maaritetty laitteille)
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Mita tapahtuu, kun kohde rikkoontuu (mitka toiminnot jaavat tapahtumatta)?

minnot voivat estya, eli mietitaan toimintojen toiminnallisia vikoja. Usein toiminnoilla voi olla useita
toiminnallisia vikoja, jotka kaikki tulisi maarittaa. Alla olevissa kuvissa (Kuvat 10 ja 11) on nahtavilla
re). Toimintaohjeen tulevissa osioissa on keskitytty kasittelemaan RCM-analyysin suorittamista osajar-
jestelman toiminnot kuvaavalla mallilla (kts. Kuva 10).

F#1 F#2
Pumpata Prsﬁytt&ﬁ ja
zmph’ristiille aloittaa
aitallista pumppaus
prosessiainetta ohjauskiskysti
500 Umin 24 ...
| I I IOR|= I I | ——1ORI=I—
FF#1.1 FF#1.2 FF#1.3 FF#1.4 FF#1.5 FF#1.6 FF#2.1 FF#2.2
Ei pumppausta Pumppaus Riittimatcn Pumppu Pumppu kiy Pumpattava Pumppaus ei Pumppaus
lainkaan kapasite etti aineen kuluttaa kuumana ja neste karkaa kaynisty prs" tyy
riittd mitsn ehitys liiallisesti jumittuu jarjestelmisti yllittien
energiaa
Kuva 10: Toimintohierarkkinen malli (toiminnalliset viat maaritetty osajarjestelman toiminnoille)
| 1ORI= I I I |
Device#1FH Device#2 FH Device#3 FH Device#4 FH Device#5 FH
Pumppu Kiyttémoottor Kytkin Tasjuusmuutta | Ohjauslogiikka
i ja
. ORI= OR|— o= OR|=
F#1.1 F#1.2 F#2.1 F#3.1 F#4.1 F#5.1
Muodostaa Muodostaa Synnyttii Vi littas Siitelee Ohjaa pumpun
haluttu haluttu pumpun momentin moottorin kayntid
tilavuusvirta nostokorkeus tarvitseman kdyttomoottori | pySrimisnopeu
momentin lta pumpun tta
akselille
T {OR[— | [OoRI=- [oRI+ [oRI+ [oRI+ [oRI+
FF#1.1.1 FF#1.1.2 FF#1.1.3 FF#1.2.1
Tilavuusvirta Ei nesteen Nesteen siirto Nostokorkeus
laskenut alle siirtoa lainkaan = ajoittaista ei riittivi
halutun < 500
[/'min

Kuva 11: Toimintohierarkkinen malli (toiminnalliset viat maaritetty laitteiden toiminnoille)

Mika aiheuttaa kunkin kohteen toiminnon puuttumisen / vajaatoiminnan?

Kohteen toiminnallisia vikoja aiheuttavat vikamuodot tulisi analyysin seuraavassa vaiheessa maarittaa
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tumisen tapoja. Vikamuotojen maarittamisessa osallistujilta vaaditaan hyvaa kohteen ja osi-
en/komponenttien tuntemista. Mallin osille/komponenteille taydennettavia vikamuotoja ovat vika-
muodot, jotka ovat jo tapahtuneet tai joiden voidaan hyvalla syylla olettaa viela tapahtuvan. Myos
inhimilliset tapahtumat on hyva sisallyttaa tahan tarkasteluun. Vikamuotoja on helpompi kasitella
aluksi laitehierarkkisen mallin kautta, vaikka analyysin tulevassa vaiheessa vikamuodot yhdistyvatkin
toimintohierarkkiseen malliin. Alla olevaan laitehierarkiamallin kuvaan (Kuva 12) on maaritetty osi-
en/komponenttien kaikki mahdolliset vikamuodot, joiden oletetaan olevan tyypillisia ja mahdollisia
(nakyvilla ainoastaan Comp#1. 1:sen vikamuodot).

Laitehierarkiapuuhun lisatty taso:

- Vikamuoto (Failure Mode) - muutettu ID (FM#)

T
Device#1 Device#2 Device#3 Device#4 Device#5
Pumppu Kayttsmoottor Kytkin Taajuusmuutta | Ohjauslogiikka
i ja
: OR! : . . ORI+ ORI+ ORI+ ORI+
Comp#1.1 Comp#1.2 Comp#1.3 Comp#1.4 Comp#1.5
Imu- ja Juoksupysra Laakerit Akseli Tiivisteet
painepuolen
putkisto
OR ORI+ ORI+ ORI+ ORI+

[
FM#1.1.1
Im!.l- jaltali

putkisto
vuotaa

v 1
FM#1.1.2 FM#1.1.3
.Pumpptl tai Liian pieni

i e 5 bt
tdysin taytetty

Kuva 12: Laitehierarkkinen puumalli (vikamuodot maaritetty)

Laitehierarkiamallin alimman tason vikamuotosolmuille voidaan analyysin tassa tai myohemmassa
vaiheessa maarittaa solmujen editoreihin vikaantumiseen ja korjaukseen liittyvia tietoja, kuten
MTTF- ja MTTR- arvot. Mallin luettavuuden helpottamiseksi vikamuotoja kuvaavien solmujen ID:t on
muutettu kuvaamaan solmutyyppia.

Projektin solmujen solmutyyppien maarittaminen

Projektin solmujen tyyppien maarittaminen nopeuttaa ja helpottaa erityyppisten solmujen yhdista-
mista projektin seuraavissa vaiheissa. ELMASiin on maaritetty oletuksena jo tiettyja solmutyyppeja.
Projektista riippuen voi olla, etta valmiiksi ehdotetut solmutyypit eivat vastaa yrityksessa kaytettyja
sista Tools -> Options -> Nodes -> Node types -> Add new node type (kts. Kuva 13). Vastaavasta pai-
kasta voidaan myo0s poistaa haluttuja solmutyyppeja. Solmutyyppien poistaminen tapahtuu valitse-
malla Node Types- listasta poistettavat solmutyypit ja painamalla Remove selected rows -nappia.
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Dptions
Personal J Node Types Connecting tool Cateqgories ]
Model Node Types
Nodes Show node type selection in editor:
FMEA
Node type title Data key
Expense Types general
Other Failure Mode
Component
Dynamic Device
Functional Failure
Function
System
Sub-system
4= Add new node type ‘ 54 Remove selected rows
Restore Default Node Type Options
{3 Restore defaults
o OK I ¥ cancel ‘ &) Help ‘

Kuva 13: Solmutyyppien uudelleen nimeaminen, lisaaminen tai poistaminen

Projektin solmutyyppien maarittaminen voidaan tehda koko projektin solmuille yhdella kertaa kayt-
tamalla ELMASin taulukkoyhteenvetotyokalua Tools -> Summary:Table (kts. Kuva 14). Saadaksesi yhta
aikaa kaikki projektin solmut nakyville taulukkoyhteenvetoon sinun tulee avata taulukkoyhteenveto-
tyokalu projektin aloitusnakyman valilehdella (kts. Kuva 4). Taulukkoyhteenvetotyokalussa valitaan
taulukossa naytettaviksi sarakkeiksi ID, Name ja Node Type. Taulukon avaamisen jalkeen solmutyyppi
voidaan valita alasvetovalikosta. Useiden perakkaisten solmujen muuttaminen samantyyppisiksi voi-

taulukkoyhteenvedossa halutuille solmuille. Vaihtoehtoinen tapa useiden samaa tyyppia olevien sol-
mujen maarittamiseksi on kayttaa apusaraketta solmutyypin monistamiseksi. Tama tapahtuu valitse-
malla taulukkoon ID, Name ja Node Type sarakkeiden lisaksi sarake (apusarake), johon projektin aika-
na ei ole maaritetty tietoja. Solmutyyppi monistuu Node Type sarakkeeseen kopioimalla haluttu sol-

taman jalkeen liittamalla kopioitu solmu valitulle alueelle.

Table Su ary Tool
Properties I Table
Summary table -
ID Name Node type
RAL1 Raaka-ainelinja General
RAL1_RAVO Raaka-aineen vastaanotto System
RAL1_LAVO Lisé-aineen vastaanotto System
RAL1_LAS Lis&-aineen siirto System
RAL1_RAS Raaka-aineen siirto System
RAL1_S Raaka-aineen ja lisd-aineen sekoitus System
RAL1_RAS_P1 Pumppausjarjestelma Sub-system
RAL1_RAS_P Raaka-aineen siirron putkistot Sub-system
DH Pumppausjarjestelma General
Devicez1 Pumppu Device
Device®2 Kayttomoottori Device
Device=3 Kytkin Device
Device®4 Taajuusmuuttaja Device
Device#5 Ohjauslogilkka Device
Comp#1.2 Juoksupyérd Component =
Comp#1.1 Imu- ja painepuoclen putkisto General
Comp#1.3 Laakerit Failure Mode
Comp#1.4 Akseli Component
Comp#1.5 Tiivisteet Device
Comp#2.1 Moottorin laakerit Functional Failure
Comp#2.2 Moottorin sdhkékompenentit Function
Comp#3.1 Kytkimen puolikkaat ja joustoelementt System
Comp#4.1 Tuuletinfjgahdytysrivat o ub-system
Comp#4.2 Taajuusmuuttajan sdhkokomponentit ,,y
Comp#5.1 Ohjauslogikan sahkakomponentit Component -]
" OK I 2 Cancel I & Help I

Kuva 14: Yhteenvetotaulukko (solmutyypin maarittaminen)
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semalla solmun editorissa solmutyyppi Type-valilehden alasvetovalikosta (kts. Kuva 15). Isoissa pro-
jekteissa aikaa ja vaivaa voidaan kuitenkin saastaa maarittelemalla solmutyypit taulukkoyhteenveto-
tyokalussa.

Edit node: FM#1.1.1 Imu=ja/tar pancpuolen putkisto vuotaa
General Node type
Type
Node type: |Failure Mode - |
Relations
General
Failure Failure Mode
Repair (Component
) Device
Line Functional Failure
Risks Function
Maintenance System
Sub-system
FMEA
Drynarmic
o OK I 3 cancel ‘ &) Help

Kuva 15: Solmutyypin maarittaminen solmun editorissa

Vikamuotojen ja toiminnallisten vikojen yhdistaminen

Tarkea osa analyysia on selvittaa vikamuotojen ja toiminnallisten vikojen tapahtumayhteys. Tama
vaihe analyysissa voidaan toteuttaa kayttamalla ELMASin yhdistamistyokalua, jolla aikaisemmin maa-
ritettyja erityyppisia solmuja voidaan nopeasti yhdistaa samalle projektivalilehdelle. Analyysin yhtena
tarkoituksena on tunnistaa tapahtumia (vikamuotoja), jotka jollain todennakoisyydella aiheuttavat
niille ominaisia toiminnallisia vikoja. Taman vuoksi laitehierarkiapuuhun maaritetyt vikamuodot tulisi
nyt yhdistaa toimintopuun toiminnallisiin vikoihin (Failure Mode - Functional Failure).

Ennen varsinaisen yhdistamistyokalun avaamista tulee ELMASin asetuksista maarittaa mita solmuja
projektissa halutaan yhdistella. Tools -> Options -> Nodes -> Connecting tool polkua pitkin paastaan
ELMAS- asetusten valilehdelle, jossa halutut solmujen yhdistamistavat voidaan maarittaa. Alasvetova-
likoissa on valittavissa kaikki aikaisemmin maaritetyt solmutyypit. Alla olevassa esimerkkiprojektin
kuvassa (Kuva 16) on erityyppisten solmujen yhdistamiselle luotu tapa, jonka mukaisesti yhdistamis-
tyokaluun syntyy vikamuodot ja toiminnalliset viat yhdistava valilehti (Failure Mode - Functional
Failure).

Dptions
Personal Mode Types | Conmecting tool | Categaries

Model

Connecting Tool Tabs

flodes Grouping node type |Cause node type Consequence node type [Model data key

FMEA Component Failure Mode Functional Failure ~|Tree
General
+= Add new connecting tool tab [Failure Mode pws
Component
Dynamic Device
Functional Failure
Function

System
Sub-system

Expense Types

Other

o OK I 2 Cancel @ Help

Kuva 16: Solmutyyppien yhdistamisehdot
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Solmujen yhdistamistapoja voi lisata painamalla Add new connecting tool tab -nappia. Taman jal-
keen valitaan alasvetovalikoista ehdot, joilla yhdistaminen suoritetaan. Yhdistettava syysolmun tyyppi
(Cause node type) yhdistetaan seuraussolmun tyyppiin (Consequence node type). Ensimmaisen sarak-
mitella samantyyppiset yhdistettavat solmut nakymaan ylemman tason solmutyypin mukaan (kts.
Kuva 17).

ELMASin yhdistamistyokalu avautuu seuraamalla polkua Tools -> Connecting tool. Ensimmaisessa sol-
mujen yhdistamisvaiheessa valitaan yhdistamistyokalun valilehdeksi Failure Mode - Functional Failu-
re. Vikamuotojen yhdistaminen toiminnallisiin vikoihin voidaan tehda joko kaikille listatuille vikamuo-
doille samanaikaisesti avaamalla kaikki vikamuodot yhdistamistyokalussa Show all Failure Mode no-
des -napilla tai jakamalla yhdistettavat solmut pienempiin ryhmiin kokoavan solmun avulla. Aikai-
semmin ELMASin asetuksissa tekemamme Grouping node type maarityksen ansiosta voimme ryhmitel-
la vikamuodot komponenttikohtaisesti (Component). Valitsemalla tietyn komponentin yhdistamistyo-
kalun ylaosan komponenttien listasta, sen laitehierarkiamalliin maaritetyt vikamuodot listautuvat
yhdistamistyokalun vikamuotojenlistaan. Vikamuotojen yhdistaminen toiminnallisiin vikoihin tapahtuu
painamalla hiiren vasenta nappia vikamuotoa ja toiminnallista vikaa yhdistavan ruudun kohdalla, jol-
loin ruutuun ilmestyy merkinta valinnasta (kts. Kuva 17). Vikamuotoon liittyvat tekijat listautuvat
yhdistamistyokalun alaosaan valitsemalla vikamuoto vikamuotojen listasta. Vikamuotojen ja toimin-

hierarkkisessa mallissa suoraan toiminnallisten vikojen alla.

Connecting Tool

Failure Mode - Functional Faiure

Select Component which Failure Mode nodes are shown

D Component
Comp=1.1  Imu-japainepuolen putkisto
Comp=1.2  Juoksupyérs

Comp=1.3  Laskerit

Comp*1.4  Aksel

Comp=1.5  Tivisteet

Comp#2.1 Moottorin laakerit

Comp#2.2  Moottorin sahkakomponentit
Comp#3.1  Kytkimen puolikkaat ja joustoelementti
Comp#4.1  Tuuletinfjashdytysrivat

Comp#4.2  Taajuusmuuttzjan sahkdkomponentit
Comp#5.1  Ohjauslogikan sahkokompanentit

Show all Failure Mode nodes

Connect Failure Mode and Functional Failure

D Failure Mode FF#1.1 Ei pumpp../FF#1.2 Pumppa...[FF# 1.3 Riittim... [FF#1.4 Pumppu ...[FF#1.5 Pumppu .. FF#1.6 Pumpatt... [FF#2.1 Pumppa... [FF#2.2 Pumppau...
FM#1.1.1 Imu-ja/tal painepuolen putkisto vuotaa J [H] [H] (] (]
FM*1,1.2  Pumppu tai imuputk ei thysin taytetty ¥ [H] [H] O (] (|
FM#1.1.3 _ Liian pieni imuputk ] ] =] ] [m] |FF#1.6 Pumpattava neste karkaa jér 3|
FM#1.1.1 Imu- ja/tai painepuolen putkisto vuotaa
Hode type D Name Gate
Parents: | Componen t Com... Imu-ja painepuolen putkisto OR.
Functional Falure  FF#... Pumpattava neste karkaa jarjestelmasts OR
o OK J 3 Cancel @ Help

Kuva 17: Vikamuotojen ja toiminnallisten vikojen yhdistaminen yhdistamistyokalulla

Vaihtoehtoinen tapa erityyppisten solmujen yhdistamiselle projektivalilehtien valilla on valita halutut
solmut projektinakyman oikean reunan solmulistasta ja yhdistaa ne halutun solmun alle. Esimerkiksi
laitehierarkkiseen malliin maaritetyt vikamuodot voidaan yhdistaa toimintohierarkkiseen malliin seu-
raavalla tavalla. Aluksi tulee avata toimintohierarkkinen malli, jonka jalkeen valitaan (maalataan)
tietyn toiminnallisen vian aiheuttavat vikamuodot oikean reunan solmulistasta. Valitut vikamuodot

oikeaa nappia ja valitsemalla avautuvasta valikosta Add selected as children -> Add all selected.
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Nyt vikamuodoille on maaritetty niiden vaikutus tutkittavan kohteen toimintoihin. Tasta tuloksena on
saatu visuaalinen malli, joka kuvaa vikamuotojen ja toiminnallisten vikojen yhteyden johtaen lopulta
jonkin toiminnon estymiseen tarkasteltavassa kohteessa (kts. Kuva 18).

\ {ORI= \
F#1 F#2
Pumpata P?siytth‘h' ja
Kmpliristlle aloittaa
aitallista pump paus
prosessiainetta ohjauskiskystsd
500 Umin 24 ...
\ T OR] I T I 1 ——ORI=——
FF#1.1 FF#1.2 FF#1.3 FF#1.4 FF#1.5 FF#1.6 FF#2.1 FF#2.2
Ei pumppausta Pumppaus Riittdm& t&n Pumppu Pumppu kiy Pumpattava Pumppaus ei Pumppaus
lainkaan kapasiteetti aineen kuluttaa kuumana ja neste karkaa kaynisty pysihtyy
riitti matan ehitys liiallisesti jumittuu jarjestelmdstad yﬁlittﬁen
energiaa
I }OR|— ] ORI+ [OR[+ ORI+ ORI+ [ORI+ ORI+ ORI+
FM#1.1.2 FM#1.3.1 FM#2.1.1
Pumppu tai Laakerit Moottorin
imuputki ei vikaantuneet laakerit
tiysin taytetty vaurioituneet

Kuva 18: Toimintopuu vikamuotojen ja toiminnallisten vikojen yhdistamisen jdlkeen

Mita tapahtuu kunkin vikaantumisen yhteydessa?

Vikamuotojen vaikutukset on hyva kuvata vikamuodon solmun editorissa oleviin FMEA-sivun Descripti-
on-valilehden kenttiin (kts. Kuva 19). Tavallisesti vikamuotojen vaikutukset jaetaan paikallisiin ja
jarjestelmatason vaikutuksiin. Vikamuotojen arvioinnissa pyritaan vastaamaan seuraaviin kysymyksiin:

- Millaisia riskeja vikaantuminen aiheuttaa terveydelle tai ymparistolle?
- Miten vikaantuminen vaikuttaa tuotantoon tai toimintaan?

- Mita konkreettisia vahinkoja vikaantuminen aiheuttaa?

- Mitka ovat korjaustoimenpiteet?

- Mista syysta vikamuoto syntyy?

- Mista nahdaan, etta vikaantuminen on tapahtunut?

Edit node: FM#1.1.1 Tmu- ja/tai painepuolen putkisto viiotaz

General J Description | RPN | Actions ]

Type Description of the Failure Mode

Relations severity (how to reduce effects):

Failure Wian vaikutus: — Millaisia riskejé vikaantuminen aiheuttaa terveydelle tai ymparistélle

Repail — Miten vikaantuminen vaikuttas buotantoon kai toimintaan
epair — Mit& konkreettisia vahinkoja vikaantuminen aiheuttaa

Line — Mitk& ovat korjaustoimenpitest

Risks Occurrence (how to reduce causes):

Maintenance Wian aiheuttaja: — Mista syystd vikamuoto synbyy

EMEA Mahdollisia syita vikamuodon syntymiselle voivat olla esim:

Inhimillinen virhe, ikiantyminen, lialinen jannite/kuarmitus,
Dynamic epapuhtaus, jne...

Detection (how to predict):

Vian havaitseminen: — Misté néhdaan, ettd vikaantuminen on tapahtunut

o OK I ¥ cancel J &) Help J

Kuva 19: Vikamuodon vaikutusten kuvaus
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Vikamuodon kriittisyyden luokitteluun voidaan kayttaa sanallisen kuvauksen lisaksi RPN-arvoa (Risk
Priority Number), joka muodostuu kolmen eri tekijan arvojen antamasta tulosta (kts. Kuva 20). Vika-
muodot arvioidaan antamalla yhden ja kymmenen valilla oleva numerokerroin niiden vakavuuden,
esiintymisen ja havaittavuuden suhteen. Naiden kolmen annetun kertoimen tulon mukaan vikamuoto
saa RPN-arvonsa. Vikamuoto on sita merkittavampi mita isomman RPN-arvon vikamuoto saa.

Edit node: FM#1.1:1 Imu-ja/tai painepuolen putkicto viotaa'
General Description I RPN | Actions

Type Rigk Priority Number of the Failure Mode
Relations

Failure
Severity (5): @ Very high -

Repair
Line
Risks
. Occurrence (0): |5Low -
Maintenance —
FMEA

Dynamic

Detection (D): ||4 Moderately high vll

Risk Priority Mumber {S*0*D):

o OK J K Cancel I & Help

Kuva 20: Vikamuodon RPN-arvon muodostuminen

Mita vahinkoja kukin vikaantuminen aiheuttaa?

Seuraavassa vaiheessa analyysia haluamme selvittaa mita seurauksia kullakin toiminnallisella vialla on
ja kuinka merkittavia ne ovat. Tahan toiminnallisten vikojen seurausten luokitteluun kaytamme sol-
mujen editoreista loytyvaa loogista paatospuuanalyysia (LTA). Seurausvaikutusten luokittelun LTA-
le vialle esitetaan sarja kysymyksia, joihin vastaamalla toiminnallinen vika ohjautuu sille ominaisim-
paan seurausvaikutusluokkaan. Toiminnallinen vika ohjautuu paatoslogiikkapuun lopuksi johonkin seu-
raavista kuudesta seurausvaikutusluokasta:

Piileva turvallisuuteen vaikuttava seuraus (HS)

Piileva tuotantoon vaikuttava seuraus (HO)

Piileva valittomia kustannuksia aiheuttava seuraus (HE)
Havaittava turvallisuuteen vaikuttava seuraus (ES)
Havaittava tuotantoon vaikuttava seuraus (EO)

Havaittava valittomia kustannuksia aiheuttava seuraus (EE)

valittavissa. Suositeltu yleinen tapa on suorittaa ensimmaisen tason LTA-tarkastelut RCM-analyysissa
toiminnallisten vikojen tasolle, mutta joissain tapauksissa voidaan joutua samat tarkastelut tekemaan
tasoa alemmaksi vikamuototasolle. Seuraavan sivun kuvassa (Kuva 21) on nakyma yhdelle esimerkki-
projektin toiminnalliselle vialle (FF#1.1 Ei pumppausta lainkaan) tehdysta paatoslogiikkapuusta ja sen

dokumentoitua ja ne on myohemmin helppo palauttaa mieleen.
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| Edit node: FF#1.1 Ei pumppausta lamkaa ¢
General LTA | Break ‘ Downtime | Repairstart | Repair time ‘ Order ‘ Resources
Type Logic decision tree analysis of effect categorization
Relations .
Detection
Failure
. Is the occurrence of a functional Failure evident | | Toiminnallinen vika imenee

Repair to the operator during the performance of kayttihenkilistille valittimasti imetessaan
Line rormal duties? automazth-imoituksens
Risks ® ves OMo
Maintenance Safety
FMEA Does the functional failure or secondary damage | | Ei siheuta henkilé- eika
Dynamic resulting from it have a direct adverse effect on | | ympéristiturvalisuudelle riskejs

operating safety or other hazardous results?

OYes @Mo
Operation
Does the functional failure have a direct adverse | | Tuotanto estyy
effect on operating cabability?
® ves O
E» (Evident Cperational): Evident Failure that affects the operation
Result of LTA:
o 0K ] 3 cancel J & Help J

Kuva 21: Seurausvaikutusten luokittelu (LTA1)
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LTA:n mukaisen seurausvaikutusluokittelun rinnalle voidaan lisaksi liittaa erilaiset simuloinnista saata-
vat kaytettavyys- ja kustannusriskitulokset seurausvaikutusten arvioinnin avuksi. Toimintohierarkkista
mallia voidaan simuloida kaytettavyys- ja riskitulostarkasteluja silmalla pitaen sen jalkeen, kun vika-
muodoille on maaritetty tietoja niiden nykyisista ennakkohuoltotoista, vikaantumisajoista, korjaus-
ajoista seka korjauskustannuksista. Toiminnallisille vioille voidaan viela maarittaa niille ominaisia
aika- tai kertaperusteisia epakaytettavyyskustannuksia. Alla oleviin kuviin (Kuvat 22 ja 23) on keratty

toimintohierarkiamallin simuloinnista saatavia kaytettavyys- ja riskituloksia.

 Analysis: Simulation Tool -
Profile [ Availability | Unreliability | Mezn times [ Studied period I |
Simulation Failures during studied period |
Basic .
Conditional
7d
Importance ID |Name [Failed time |Failures
Rigks FH Pumppausiariestelms W0dish 64,704 6d
. FF#1.5 Pumppu kiy kuumana ja jumittuu 4d8h 19,428 =
Line FF#2.1  Pumppaus ei kiynnisty id4h 16.333
FF#1.4 Pumppu kuluttaa lialisest energiaa 3d21h 16,639 a4 . ~
FF#£2.2  Pumppaus pysahtyy yllattsen id4h 16.135 /,-"
FF#1.6 Pumpattava neste karkaa jérjestelmésts 2d 17h 13.361 2d /_/’/
FF#1.1 |Ei pumppausta lainkaan 2d11h 12,213 X ’_//
FF#1.2 Pumppauskapasiteetti rittdmatan 1d18h 5,409 /,/ . T
FF#1.3 Riittamatin paineen kehitys idigh 8,409 1d — B _—
L e
- - 2a 43 L] 8a 10a
: | Min (%) — Mean — Max (35%)]
Profle Selections | General | Reduction | Achievement ]
Show graph plots table
Simlation Reduction results
Basic
Conditional
e Mean time that consequence is failed: 4d&h
Risks Mean number of failures of consequence: | 19.429
Line
1D |Hame [Time = [Time (20) |Count |Count (20) |
FM#1.3.1 Laakerit vikaantuneet id20h 42.5 5.509 23,35
FM#1.2.1 |Juoksupy®ra kulunutfjucksupyérén lav... 1d9h 3131 4.048 20.83
FM#3.1.1 |Linjausvirhe 14h 31 min 13.93 4,794 24,68
FM#2,1.1  Moottorin laskerit vauricitunest 10 h 12 min 2.79 2.56 13.18
FM#3.2.1  Kytkin kumi kulunutfrikkoutunut 2h 32 min 2,427 2.501 12.87
Kuva 22: Seurausvaikutusten luokittelu (kaytettavyys)
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i"“'lﬁf‘:l" ulation Tool ‘

Profile J Entity risks | Mode risks | Subiree risks ‘ Relative risks | Comb.risks | Human resources ]
) ) |
Simulation Risks of the entity
Basic o )
Conditional Studied time period: | 10 3 l Cumulative | Distribution I Stack ]
onditional
ks 700 000
Impartance Total rigk: 634 708 €
) 500 000
= Type of risk Risk (€)
Line Downtime 640 655 500 000
Repair start 30871 400 000
Repair time 23 182

300 000

200 000

Ana \Iﬁf‘ﬂ"‘ ulation Tool

100 00O

Profile [ Entity risks | Mode risks Subtree risks [ Relative risks | Comb.risks
[}
Simulation Relative risks 22 4a 82 82 o=
Basic |n Downtime & Repair start Repairtime|
Studied time peried: [ 103

Conditional ) Show graph plots table
Importance Show also zero lines: [
Risks i3] Name Downtime (€) |Repair start (€) |Repair time (€) [Relative risk (€) -
Line FH Pumppausjarjestelma 540 655 30871 23182 594 708

FM#1.2.1 Juoksupytra kulunutfjucksupyiran,.. 173 677 6 085 3264 183026

FM#1.3.1 Laakerit vikaantuneet 117501 5521 4431 127 853

FM#1.5.1 Tivisteet vuotaa 49632 5018 3734 58 435

FM#1.4.1 Akseli taipunut 43517 4058 3271 50846

FM#2.2.1 Moottorin séhkékamponentti vikaa... |42 357 1811 1195 45 363

FM#2.1.1 Moottorin lazkerit vaurioituneet 40 743 1283 1021 43046

FM#1.1.1 Imu-ja/tai painepuolen putkisto vu... 37 345 355 2807 40 506

FM#3.1.1 Linjausvirhe 3Be41 0 1452 40093

FM#4.2.1 Taajuusmuuttajan shkékomponen... |20 998 6161 592 27751

FM#4.1,1 Taajuusmuuttaja ylikuumenee 21205 0 598 21803

FM#1,1.3 Liian pieni imuputki 19 337 0 1] 19 337

FM#5.1.1 Ohjauslogikan sahkokomponentti v... 16 208 454 229 16891

FM#1,2.2 |VEEra pydrimissuunta 10 151 0 127 10278

FM#1.1.2 Pumppu tai imuputli ei tiysin tdyte... 5528 0 208 5735

FM#3.2,1  Kytkin kumi kulunut/rikkoutunut 3365 125 253 3743

Kuva 23: Seurausvaikutusten luokittelu (kustannusriskit)

Edella kuvattujen seurausvaikutusten luokittelulla ja erilaisilla riskianalyyseilla on tarkoituksena tuoda
esille potentiaalisimmat kohteet (vikamuodot), joista oikeilla ennakkohuoltotehtavilla on mahdollista
saada paras tuotto investoinneille. Investointeina voidaan tassa tapauksessa pitaa huoltokustannuksia,
uudelleensuunnittelua tai muita tilannetta parantavia toimenpiteita. Kuten jo aikaisemmin toiminta-
ohjeen alkupuolella todettiin, poikkeuksen potentiaalisimpien kohteiden listaan tekee turvallisuus- ja
ymparistoseuraukset, jotka kustannuksista riippumatta siirtyvat seuraavan vaiheen tarkasteluihin.
Toisin sanoen, mikali toiminnallinen vika on saanut LTA- kysymyspolun paatteeksi HS- tai ES- seuraus-
vaikutusluokituksen, on kaikille sen aiheuttamille vikamuodoille pakko suunnitella ehkaisevia toimen-
piteita. Analyysin seuraavassa vaiheessa jokaiselle kriittiselle vikamuodolle pyritaan loytamaan sovel-
tuvin ja tehokkain ennakkohuollollinen toimenpide kyseisen vikamuodon valttamiseksi tai siita aiheu-
tuvien seurausten lieventamiseksi.

Kuvassa 24 on nahtavilla esimerkkiprojektin toimintohierarkkinen malli seurausvaikutustarkasteluiden
jalkeen. Toiminnallisia vikoja kuvaaville solmuille on ilmestynyt kullekin ikoni kuvaamaan sille LTA-
kysymyspolun lopuksi muodostunutta seurausvaikutusluokkaa. Paatoslogiikkapuun myota toiminnalli-
laitteiden/komponenttien/vikamuotojen soveltuvimmasta kunnossapitostrategiasta. Seurausvaikutuk-
siltaan merkittavimpien toiminnallisten vikojen huollot on pakko tehda (HS ja ES) ja vahemman mer-
kittavampien toiminnallisten vikojen huollot pitaisi (HO ja EO) tai voisi (HE ja EE) tehda.
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F#2

Pysdyttdd ja
aloittaa
pumppaus
ohjauskiskystd

F#1

Pumpata

zmpiristiille
aitallista

prosessiainetta
500 Umin 24 ...

T T ORI— T T T ] [ 1ORI=—
FF#1.1 FF#1.2 FF#1.3 FF#1.4 FF#1.5 FF#1.6 FF#2.1 FF#2.2

Ei pumppausta Pumppaus Riittamaton Pumppu Pumppu kiy Pumpattava Pumppaus ei Pumppaus
lainkaan kapasiteetti aineen kuluttaa kuumana ja neste karkaa kiynisty p{s" tyy
riitti mitsn chitys liiallisesti jumittuu jirjestelmistid yllittien
energiaa
EO EO EO EE EE ES EO EO
I OR — ] OR|+ OR|+ OR|+ OR|+ OR|+ OR|+ OR+
FM#1.1.2 FM#1.3.1 FM#2.1.1
Pumppu tai Laakerit Moottorin
imuputki ei vikaantuneet laakerit
taysin taytetty vaurioituneet

Kuva 24: Toimintohierarkkinen malli (seurausvaikutukset maaritetty LTA:ssa)

Projektitiedoston tallentaminen uudella nimella

teen nykyisen toiminnan kuvaamiseen. Projektin seuraavassa vaiheessa siirrytaan arvioimaan erilais-
ten tehtavien ja toimintamallien vaikutusta kohteen toimintaan. Analyysin seuraavissa vaiheissa maa-
ritettyjen toimenpiteiden vaikutuksia kohteen toimintaan voidaan vertailla alkuperaisesta mallista ja
uudesta mallista saatujen simulointitulosten perusteella. Tata varten alkuperaista ja uutta tilannetta

uudella nimella ennen seuraavaa tyovaihetta eli tehtavien maaritysta.

Mita voidaan tehda kunkin vikaantumismallin havaitsemiseksi riittavan ajoissa tai
vikaantumisen estamiseksi?

niiden seurausluokituksen perusteella. Erityyppisten huoltotehtavien soveltuvuuden ja tehokkuuden
tarkastelu tehdaan huollettavaa tasoa kuvaaville vikamuotosolmuille solmujen editoreissa Maintenan-
syys (Criticality) alasvetovalikosta (kts. Kuva 25). Usein vikamuodon kriittisyys on sama kuin sen aihe-
uttamalla toiminnallisella vialla. Seurausvaikutus ei kuitenkaan periydy vikamuodolle suoraan edelli-
sen vaiheen toiminnalliselta vialta, vaan kayttajan tulee valita vikamuodon kriittisyys erikseen alasve-
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General | Replacement | Finding | Redesign | RTF
Type LTA | Preventive | Inspection | Restoration ]
Relations Logic decision tree analysis of maintenance
Failure o
Criticality: | -|
Repair
Line Evident failure that affects the safety (ES)
Risks Evident failure that affects the operation (EC)
_ Evident failure that causes costs (EE)
Maintenance Hidden failure that affects the safety (HS)
FMEA Hidden failure that affects the operation (HO)
) Result of LTHidden failure that causes costs (HE)
Dynamic l ‘
o 0K I 3 Cancel ‘ &) Help ‘

Kuva 25: Vikamuodon kriittisyyden arviointi (LTA2)

Vikamuodon kriittisyys-luokituksesta riippuen vikamuodolle esitetaan erilaisia kunnossapidettavyyteen
liittyvia kysymyksia. ”Kylla” tai ”Ei” vastauksen lisaksi on suositeltavaa kirjata tekstimuotoinen kuva-
us mahdollisten tehtavien soveltuvuudesta ja tehokkuudesta erityyppisten huoltotehtavien kysymys-
syntyy ehdotus sopivimmasta kunnossapitoluokasta. Jokainen tehtavatyyppi suunnitellaan tarkemmin
omalla valilehdellaan, joita ovat Preventive, Inspection, Restoration, Replacement, Finding, Redesign
ja RTF. Nailla tehtavatyyppien valilehdilla voidaan tarkemmin tarkastella erityyppisten tehtavien so-
veltuvuutta ja tehokkuutta tarkasteltavalle vikamuodolle. Erityyppisten ennakkohuoltotehtavien so-
veltuvuuden ja tehokkuuden tarkastelussa arvioidaan vikamuodon oirehtimiseen liittyvien oireiden ja
aikojen lisaksi ian vaikutusta vikaantumistodennakoisyyteen, suoritusvaleja, resursseja ja huoltoteh-
tavasta aiheutuvia kustannuksia. Soveltuva ja tehokas toimenpide on kuvattava tarpeeksi yksityiskoh-

tehtavasta.

Kuvassa 26 on nahtavilla koko FM#1.3. 1 Laakerit vikaantuneet -vikamuodolle suoritettu soveltuvimpi-
en ja tehokkaimpien tehtavien maarityksen kysymyspolku. Vikamuoto on kysymyspolun paatteeksi
saanut ehdotukseksi aikataulutetun kunnossapidon (Scheduled maintenance) sille soveltuvimmaksi
kunnossapitoluokaksi.
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Vo2 Logic decision tree analysis of maintenance
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) Criicaity: t affects the operation (E0)
Fahre
Resar
e
Risks
Lubricafion and senvicng tasks
Maintznance
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Smices a(tnnmtherizlaal Tnspection”. I an aplcable and effedtive
intenance action s found ncuiry path can be frished o tislewel p——
)res
Restoraton
s 2 restorstion task applicabie and sffectie for redutng Failrs rate? Before Eitehokas
. TF an aoph s found iy
Firished on ths evel. =
Oves @
Repiacement
T erete bt e el | SR
Fire
the et Replecement’, IF an applicabie and
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Jres @)
Task combinaon
e e et P R e e i e[ vk vt
E c
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Redesen
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@res Omo
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Kuva 26 SoveItUVIen ja tehokkaiden tehtavien maarittaminen piilevalle tuotantoon vaikuttavalle vikamuodolle (LTA2)

Vikamuodolle FM#1.3.1 Laakerit vikaantuneet maaritetty kunnonvalvontatoimenpide on nahtavissa
seuraavassa kuvassa (Kuva 27) Ominaiseksi P-F jaksoksi vikamuodolle on arvioitu 40 p'aiivéé Symptom

kohteen t01m1nnalllseen v1kaantumlseen. Usein tarkasteltavan kohteen P-F -jaksot eivat ole vakioita
vaan niissa esiintyy vaihtelevuutta. Talloin huoltovalit tulisi maarittaa lyhimman P-F -jakson mukai-
sesti. Vikamuodon oireita on kuvailtu Failure symptoms -kenttaan. Varsinaiselle huoltotehtavalle
maaritettyja asioita ovat huoltovali, huoltokerran kustannus seka kommentit kenttaan kirjatut tyon
nimi ja suorittaja. Huoltovalin Repeat-kentta on valittuna silla oletuksella, etta tyo toistetaan maari-

tetyn ajan valein.

Gereral [[7a [ Preventive | nspection | Restoration | Replacement | Finding | Redesign | RTF |
Type Inspections
Relations

Generaly it s reasonable to carry out the scheduled coneltion monitering actions, if 1)t is possible to

Failure define and detect the symptoms of the failure sarly enough, 2) P-F-period (Point Failurs) is moderately
Repair solid and 3} it s practical ta control the object in shorter time periods than the P-F-period.
Line Warahtelymittauksila (spektrivalvonta) havaittawat kohonneet
) Faitre symptoms: | 123KEreiden ikataajuuden amplitueit osoittavat vikaantumisen
Risks ymptoms: kehittymista. Lopulta laakerit [3mpenevat ja alkavak pitamadn aarka,
— jonka jalkeen kaydellinen hajoaminen on jo hyvin lahella.
FMEA Sympttom detect time: [m.u ] d (=]
Dynamic
Inspection time (d) |Cost of an inspection (€) [Comments |Repeat |
TYOM NIMI: Varahtelymittaus
a0 50 SUCRITTAIA: Ennakkahuoka
ik adg inspecton | || Remove selected rons |
Inspection interval unit: d [~
Only first from the list if overlap:
ok ||[ 3¢ cancel ] © Help ]

Kuva 27 Vlkamuodolle FM#1.3.1 Laakerit vikaantuneet maaritetty tarkastustehtava
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Mita tehddan, jos sopivaa ennakoivaa toimenpidetta ei loydy?

ennakkohuoltotoimenpidetta, tulisi tarkastella muita mahdollisuuksia vaikuttaa vikamuotojen toteu-
tumiseen. Usein esim. inhimillisista virheista tai suunnitteluvirheista aiheutuneille vikamuodoille ei
syy on toimintatavoissa, joihin ei voida ennakkohuollon keinoin varautua. Kriittiset vikamuodot, joihin
ennakkohuollolla ei voida vaikuttaa, huomioidaan RCM- analyysissa kertaluonteisilla toimenpiteilla tai
toimintaohjeilla.

Esimerkkiprojektin vikamuoto FM#1.1.2 Pumppu tai imuputki ei tdysin tdytetty on kysymyspolun
paatteeksi saanut RTF-luokituksen (Run-to-failure), eli sille ei tehda aikaan eika kuntoon perustuvaa
kaantumisen korjaamisesta huollon RTF-valilehdelle. Lisaksi ajatuksia voidaan kohdistaa muutostoi-
menpiteisiin, joilla RTF-luokituksen saanut vikamuoto voitaisiin poistaa tai vahentaa siita aiheutuvia
seurauksia. Potentiaalisimpia vikamuotoja tallaisille tarkasteluille ovat jo aikaisemminkin mainitut
suunnittelusta ja inhimillisista virheista aiheutuvat vikamuodot. Esimerkkiprojektin kuvassa 28 on
kuvattu yhden inhimillisesta virheesta aiheutuneen vikamuodon poistamiseksi tehtyja toimenpiteita.

Vikamuodolle on maaritetty erillinen kertaluontoinen tehtava FMEA-sivun Actions-valilehdelle, jolla

tehtavat on hyva kirjata ylos kyseiselle valilehdelle, jossa niiden edistymista voidaan seurata.

Edit node: FM#1.1.2 Pumppu tai imuputhi ei taysin taytetty
General Descrption | RPN | Actions |
Type Actions
Relati
eations Recommended Action [Responsible  |Due date  |State \Action taken s o D RPN
Failure Alkuperzinen tilanne 1.1.2010 Lahkgtilanne  Ei aikataulukettuja huolkokoimenpiteits
. 4 9 288
Repair
Line Koulukuksen jarjestaminen  Mekaanisen 19.5.2010  Suunnittelu  Paikka ja aika sowittu
Risks kaytts- ja kunnossapidon 8 4 9 238
18 kunnossapitohenkildstalle  kvdnjohto
Maintenance Chjegistus pumpun Mekaaninen 21.6.2010  Suoritetty IMekaaninen kunnossapito- ja
esitaykista pumpun kunnossapito ja kayttahenkilastd ohjeistettu pumpun 3 1 2 72
FMEA kayttaiille ja kayttd huollon jalkeisessa kaynnistyksessa
Dynamic kunnossapit 3jile huomicitavista asivista
Uusi tilanne 23.6.2010  Uusi Ohijeistusta parannettu 8 1 9 72
4= Add action I =} Remove selected I
ok || % cancel J @ Help ]

Kuva 28: Vikamuodolle maaritetty muu kertaluonteinen tehtava ja sen edistyminen

Analyysissa maaritettyjen toimenpiteiden vaikutusten arviointi

Analyysin aikana maaritettyjen toimenpiteiden vaikutusta kaytettavyyteen ja kustannusriskien synty-
miseen voidaan tarkastella laite- tai toimintohierarkkista mallia simuloimalla. Simulointituloksia tar-
kastellessa tulee huomioida, etta ohjelmisto olettaa, ettei simuloinnin aikana tarkastus- tai kunnon-
valvontatoimenpiteella havaitun oireilevan vikaantumisen korjaaminen aiheuta lainkaan seisontame-
netyksia eika korjaukseen valittomasti liittyvia kustannuksia. Lisaksi vikamuodoille maaritettyjen Re-
design- ja RTF-toimenpiteiden kustannukset eivat siirry lainkaan simuloinnin riskituloksiin.

Esimerkkiprojektin simuloinnista saatavista suhteellisista riskituloksista (kts. Kuva 29) voidaan havai-
ta, etta toiminnon F#1 Pumpata ympdristolle haitallista prosessiainetta 500 [/min 24 h/vrk toimin-
nan varmistamiseen tullaan kayttamaan reilut 25 000 € kymmenen vuoden aikana RCM-analyysissa
suunniteltujen ennakkohuoltotoiden johdosta. Toiminnon odotetaan suoritettavista EH-toista huoli-
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matta aiheuttavan lahes 100 000 € seisontamenetykset tarkastelujakson aikana. Suhteellisten riskitu-
losten valilehdella on Maintenance % -sarake, jossa huoltokustannusten osuutta verrataan simuloinnis-
sa syntyviin epakaytettavyyskustannuksiin (mm. seisontamenetys seka korjauskerran ja korjausajan
kustannukset). Suuri Maintenance % -osuus kuvaa kunnossapitoon kaytettavien resurssien olevan lahel-
la syntyvia epakaytettavyyskustannuksia ja painvastoin. Suhteellisista riskituloksista voidaan havaita
esim. kohteet, joita yli- tai alihuolletaan.

Analysis: Simulation Tool

Profile Entityrisks | Noderisks | Subtreerisks | Relativerisks | Comb.risks | Human resources }

Simulation Relative risks

Basic

Steed e perac

Conditional

Importance Show also zero lines: [

Risks ) Hame Downtime (€) _[Repair start (€) [Repair time (€) |Maintenance (€)Maintenance (%) |Relative risk (€)

Line F=1 Pumpata ymparistélle haitalista pro... 97 140 11 3788 25 9.8 127320
Fx2 Pysayttas ja aloittaa pumppaus oh... 42 183 2091 1249 10 260 18.3% 55 784
FF#L1  Epumppausta lainkaan 4283 317 246 6810 58.43 1165
FF#12  Pumppaus kapasiteettiittematon 7710 469 345 00 6.575 9124
FF#L3  Rittamaton paineen kehitys 7710 469 345 00 6.575 9124
FF#14  Pumppu kuluttsa lislisesti energiaa | 16 848 76 871 6655 26.46 25150
FF#15  Pumppukéykuumana ja jumittuu 13510 785 m 9390 38.39 24462
FF#16 Pumpattava neste karkaa jarjestel... 47079 143 2709 14315 22.28 64 296
FF#2.1  Pumppaus el kaynisty 19 182 2091 1076 7115 24.15 29465
FF#2.2  Pumppaus pysshtyy yliattaen 23001 1890 1210 8490 24.58 34341
FH Pumppausjérjestelma 139 323 3278 5037 35465 19.37 183 103
FM#1.1.1 Imu-jaftai painepuolen putkisto vu... 45 326 0 2608 7815 14.02 55749
FM#1.2.1  Juoksupyra kulunut/jucksupyéran... 17 138 463 247 00 3.252 18453
FM#1.2.2 Vaara pyorimissuunta 10277 i) 99 o 0.0 10375
FM#1.3.1 Laakerit vikaantunest 728 268 209 4235 35.41 11959
FM#1.4.1  Akseli taipunut 3537 258 04 1500 27.28 5499
FM#15.1 Tivistest vuotaa 1753 143 01 5500 76.5 8497
FM#2.1.1  Moottorin laakerit vaurioituneet 197 4 B 2575 55.52 45638
FM#2.2.1 Moottorin sahkskomponentti vikaa... 23 165 1235 810 2250 5.194 27 460
FM#3,1.1 Linjausvirhe 9885 i) 284 1980 16.3 12 150
FM#4.1.1 Tasjuusmuutizja yikuumenee 4940 0 173 3145 38.08 8258
FM#4.2.1 Tasjuusmuuttajan sshkakomponen... 1121 401 3 1820 53.82 3382
FM#5.1.1  Ohjauslogikan sahkskompanentt v... 12957 456 227 3045 18.25 16 684

Kuva 29: Simuloinnin Suhteelliset riskit -valilehti

Analyysista saatavat raportit

Tehtavien hyvaksynnan jalkeen RCM-analyysista on mahdollista luoda erilaisia raportteja. Analyysin
yleisia asioita voidaan liittaa esim. HTML- tai Excel-muotoisiin raportteihin. HTML-raportti luodaan
Tools -> Summary:HTML polkua pitkin. HTML-yhteenvedon alustusnakymasta (kts. Kuva 30) voidaan
valita raporttiin liitettavat datakentat Edit selections -napista painamalla. Datakentta liitetaan osaksi
raporttia valitsemalla se avautuvasta hierarkkisesta puusta ja hyvaksymalla valinnan Select-nappia
painamalla. Valittuja datakenttia voidaan poistaa valittujen joukosta valitsemalla listasta aikaisem-
tietoja voi kirjata HTML-yhteenvedon alustusnakyman tietokenttiin. Raportti luodaan valittujen data-
kenttien ja kirjattujen yleistietojen mukaisesti Create HTML summary -nappia painamalla. ELMAS luo
HTML-raportin Users/kdyttdjda/ELMAS/temp -kansioon ELMAS HTML-yhteenveto - Otsikko -nimella.
Raportti (kts. Kuva 31) on taman jalkeen tarkasteltavissa View-nappia painamalla, jolloin se avautuu
oletuksena olevalle Internet-selaimelle.
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T oy T e

Selected data fields

Iin]

Mame

Result of LTA

Result of LTA

|Actions when failure occurs
Severity (how to reduce effects)
Occurrence (how to reduce causes)
Detection (how to predict)

Actions
I Load selections. . ] I Save selections.. ] { Edit selections...
ELMAS HTML Summary
Title: ‘Raaka-aine\inja
Description: Pumppausjariestelms
Motes:
Project name: RCM-analyysi
Created: 11.8.2010
Responsible: Famentor Oy
Summary of: [a\l nodes of current tab I:J]
Show node pictures: [as links I:J]

Style: [compact I:J]

[ Create HTML summary
— View

l o OK ” K Cancel H &) Help

ELMAS RAMoptim Dynamic v4.3.45 (23.8.2010)

Kuva 30: HTML-yhteenvedon alustusnakyma

ELMAS AT

£ Cblse Wil ELWAS e ELMAS HTMIL Summary - Raske-ainelinstinde bt [ ir ] % 65 Live Search £ -

Yo Suoskt | gy @8 ottt snasman @) Web Shce valiaiens ¥

B @ - - mwe See Teeae @ 7

18 ELMAS HTML Summary.

Raska sinclia FM:#1.1.2 Pumppu tai imuputki ei taysin taytetty

= [OR] FH Pumspausjaustsima
= [0R] F#1 Pumgata ympanstali haitallta prosessiainsita 500 Umin 24 hivk General

= [OR] FF#.1 Ei pumppansta lainkaan
FMA1.12 Pumppu tai imupulki o taysin taytusty 3 P12

61 31 Laakar kasriunnat 3 e
FNIZ.1.1 Moottarin |askent vauricilunest = ST O R IR
= [OR) FF#1.2 Purnppaus K 3s1ést nitindton
e 13 o it ot RiskLTA
N1 2.1 J00keUpy e Klurs ok oy s Lsgunsel
N1 22 Vi priimissuints Hesalt of LTA: Lo decion 90 srbyes ofsfct cogortin i v yot e
= OR) FF#1 3 Ritsenaten paneen kehiys
113 L s imputks .

I 21 JUok uUpy o kudrat ok g bran kvt et
FM#1 2.2 aars ptimissnets
= 10R] FF# & Purmppu kus1as ialisssi anargisa
FM1 2.1 Juoksupytea kuuraeuoksupyoran bast apumsst
P 4 1 st taigunut RTF
FM#1 22 Vaara pysimissunets
FMAC. 1.1 Mosttorin sakert vaurcitumeet
M1 1 Linaurithe Sy Titls |Cost(6) Responsibie Comments
= JOR] FFH# 5 Pumppu kay kuumana ja pamiias Faululus 1 000 Wik aninen kurmossapid 3 harlto
FM#1 2 1 Juokeupytes kuluna uoksupybran bavat tipuneet
FME1 3.1 Laskesit wkasrduneel
FIHE1. 1 Mosttonn 88kent vaunciluneet Description "

Result of LTA: Propased action: Ho schetuled maimtenance. Defne the mstnactions more accurately on th intesieal "ATF"

FIL 1 Lijsussihe
121 Kythin i balunulikoutunat Vian vk ViRamUgto & aitarskejs arkluealisasdela sk yrasisile
= OR) FF#1 & Purnpiltsns it kirkan jnesteimssta Tuotanio xlyy viksmuodon johdusta
N1 1 i 4131 DainEpulen putkisto mtss L Frp—
N1 5.1 Tiactesl ot konmstaimargtats "
> [OY FIZ Pyasiba s sohss sumppaus ohsuskaskysts Puampun pesi luke (4714 nesizel s akistas et imupuki on kkonaan nestepinnan sspuoisl
= ORI FF42 1 Pursgpas & kaynisty Ocrurrence fhow o reducs causes: Vian aieuttaa Vicamunto syresy asemnuseshasn ta nhimilisen artyksan jchsosta
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Kuva 31: HTML-raportti

Vastaavanlainen raportti on mahdollista luoda myos Excel-muotoon. Excel-raportti (kts. Kuvat 32 ja
33) luodaan painamalla Write data to Excel file -nappia ja nimeamalla Excel-raportti seuraavan polun

paatteeksi Tools -> Summary:Excel -> Export.
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Kuva 32: Excel-raportin tallennusnakyma
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Kuva 33: Excel-raportti

Taulukkomuotoisia raportteja analyysista voidaan

Design. Analyze. Optimize.
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taulukkoyhteenveto- tai FMEA-

taulukkotyokalun avulla. Taulukkoyhteenvedon (Tools -> Summary:Table) Properties-valilehdella
(kts. Kuva 34) maaritetaan taulukossa naytettavat tietokentat. Taulukkoon voidaan sisallyttaa projek-
tivalilehden kaikki solmut valitsemalla Show all nodes of current tab aktiiviseksi tai vain mallin
alimman tason juurisolmut aktivoimalla Show only root nodes of current tab. Taulukko luodaan va-
littujen tietokenttien mukaisesti, joko painamalla Open table -nappia tai siirtymalla Table-
valilehdelle. Taulukkoyhteenvedossa luotu taulukko (kts. Kuva 35) on mahdollista kopioida liitettavak-
si Exceliin painamalla taulukon paalla hiiren oikeaa nappia ja valitsemalla avautuvasta valikosta Copy

whole table-toiminto.
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Kuva 34: Taulukkoyhteenvedon tietokenttien maarittaminen Properties-valilehdella
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Table Summary Tool
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Kuva 35: Taulukkoyhteenveto

Lyhyt toimintaohje ELMAS FMEA-RCM etenemisesta

1. Kohteen valinta tuotantolinjan lohkokaaviomallista esim. simuloinnin kaytettavyys- ja riskikus-
tannustulosten pohjalta.

2. Valitun kohteen tarkempien rajojen maarittaminen laitehierarkiamalliin Device hierarchy pro-
jektivalilehdelle:
- Osajarjestelma (Subsystem)
- Laite (Device)

- Osa/komponentti (Item/Component).

3. Kohteen toimintojen puumallin luonti Function hierarchy projektivalilehdelle.
- Osajarjestelma (Subsystem) = ID muutettu laitehierarkiamallissa kaytetysta.
- Osajarjestelmien (tai haluttaessa laitteiden) paa- ja sivutoimintojen (Functions) maa-

rittaminen suorituskykytasot mukaan lukien .
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- Toiminnalliset viat (tavat, joilla osajarjestelmien toiminnot voivat estya) (Functional
failure).

- Laitteiden toimintojen kuvaukset voidaan haluttaessa kirjata solmun editorin Descrip-
tion-kenttaan. Laitteiden toiminnot voidaan haluttaessa kuvata myos omina solmui-
naan Function hierarchy -projektivalilehdella.

- Vikamuotojen maarittaminen osille/komponenteille. Nimeamisessa suositeltavaa il-
moittaa myos komponentti, jonka vikamuodosta on kyse. Tama helpottaa vikamuoto-
jen ja toiminnallisten vikojen yhdistamisen jalkeista luettavuutta.

- Vikamuotojen tapahtumiseen liittyvat tiedot, kuten esim. vikavalit, korjausajat ja kus-
tannusriskit tulisi syottaa solmun editorin Failure-, Repair- ja Risks-sivuille.

6. Device hierarchy -projektivalilehden vikamuotojen yhdistaminen Function hierarchy -
projektivalilehden toiminnallisten vikojen alle.
- Mika tapahtuma aiheuttaa toiminnallisen vian?

7. Vikamuotojen vaikutusten maarittaminen solmun editorin FMEA-sivulle. Vaikutuksia arvioi-
daan seuraavien kysymysten pohjalta:
- Mista nahdaan, etta vikaantuminen on tapahtunut? (Detection)
- Millaisia riskeja vikaantuminen aiheuttaa terveydelle tai ymparistolle?
(Severity)
- Miten vikaantuminen vaikuttaa tuotantoon tai toimintaan? (Severity)

Mita konkreettisia vahinkoja vikaantuminen aiheuttaa? (Severity)

Mitka ovat korjaustoimenpiteet? (Severity)

- Vikamuodon aiheuttaja(t) eli syyt vikamuotojen syntymiselle voidaan listata vikamuo-
don solmun editorin FMEA-sivun Description-valilehden Occurence-kenttaan. Pienem-
missa kohteissa vikamuodon aiheuttajat voidaan lisata vikamuotojen alle omina sol-
muinaan ilman, etta mallin luettavuus karsisi siita.

- Vikamuotojen vaikutusten numeerinen arviointi RPN-arvolla solmun editorin FMEA-
sivun RPN-valilehdella.

8. Toiminnallisten vikojen seurausten arviointi.
- Toiminnallisen vian seurausvaikutukset arvioidaan solmun editorin Risks-sivun LTA-
valilehdella.

nallisen vian kunnossapitostrategiana.

9. Projektin tallentaminen uudella nimella.
- Alkuperainen tilanne kuvattu - Seuraavaksi suunnitellaan toimenpiteita alkuperaisen
tilanteen parantamiseksi.
- Suunniteltujen toimenpiteiden vaikutuksia simulointituloksiin voidaan jatkossa vertail-
la helposti tallentamalla alkuperaista ja uutta tilannetta kuvaavat mallit omilla nimil-
laan.

- Tehtavien maarittaminen suoritetaan vikamuodoille, jotka aiheuttavat edellisessa vai-
heessa kriittisimmiksi maaritettyja toiminnallisia vikoja.

- Vikamuodoille, jotka aiheuttavat HS- tai ES-luokan seuraukset, on pakko tehda paran-
tavia toimenpiteita. HO- ja EO- luokiteltujen toiminnallisten vikojen vikamuodot pitai-
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si pyrkia estamaan huoltotoimenpiteella tai muilla keinoin. Vahimmalle huomiolle voi-
daan jattaa vikamuodot, joiden aiheuttamien toiminnallisten vikojen seuraukset ylta-
vat ainoastaan HE- tai EE-seurausvaikutusluokkaan.

taan vikamuotojen solmujen editoreissa Maintenance-sivun LTA-valilehdella.

Ennen soveltuvimpien ja tehokkaimpien toimenpiteiden maaritysta tulee alasvetovali-
kosta valita vikamuodon kriittisyys LTA-valilehdella (usein sama kuin sen aiheuttamalla
toiminnallisella vialla). Vikamuoto, joka aiheuttaa eri seurausvaikutusluokan omaavia
toiminnallisia vikoja, tulee arvioida kriittisimman seurausvaikutuksen mukaan. Seura-
usvaikutusluokka ei periydy suoraan toiminnalliselta vialta vikamuodolle.
Toimenpiteiden maarityksen paatteeksi vikamuodolle ehdotetaan sille sopivinta kun-
nossapitoluokkaa LTA-valilehdella.

ja huoltokustannuksiin voidaan tarkastella simuloimalla projektin eri valilehtia.

Simuloimalla omilla nimillaan tallennettuja alkuperaista ja uutta tilannetta kuvaavia
malleja voidaan arvioida analyysissa maaritettyjen toimenpiteiden vaikutuksia.

Esille alkuperaiset ja uudet kaytettavyydet, vikalukumaarat ja epakaytettavyyskustan-
nukset.

Epakaytettavyyskustannuksien ja huoltokustannusten suhde - Ylihuollet-
tu/alihuollettu.

Turvallisuus- ja ymparistoseurausvaikutuksia aiheuttavien toiminnallisten vikojen vika-

toimenpiteita, jos toteutumisen todennakoisyys edelleen suuri.

12. Raportointi

Ramentor Oy
P.0. Box 916

Analyysista saatavia raportteja ovat: HTML- ja Excel-muotoisten raporttien lisaksi eri-
laiset taulukkomuotoiset yhteenvedot.

HTML-raportti luodaan Tool -> Summary:HTML -> Create HTML summary. Raportista
syntynyt kansio loytyy Users/kdyttdjd/ELMAS/temp -polusta. HTML-raportti avautuu
Internet selaimeen View-nappia painamalla.

Excel-raportti luodaan Tools -> Summary:Excel File -> Export -> Write data to Excel
osta maaritetyn nimen mukaisena.

Solmujen FMEA-sivun Description- ja RPN-valilehdille kirjattuja kuvauksia voidaan koo-
ta taulukkomuotoon (Tools -> FMEA tool -> Table). Taulukon siirtaminen Exceliin ta-
pahtuu painamalla taulukon paalla hiiren oikeaa nappia ja valitsemalla avautuvasta
valikosta Copy whole table, jonka jalkeen taulukko on liitettavissa Exceliin.

Solmujen FMEA-sivun Actions-valilehdille kirjatut toimenpiteet on mahdollista koota
yhdeksi toimenpidetaulukoksi Tools -> FMEA tool -> Actions summary polun paatteeksi
loytyvaan toimenpiteiden taulukkoon. Toimenpidetaulukon siirtaminen Exceliin tapah-
tuu vastaavalla tavalla, kuin edellisen vaiheen taulukon siirto.

Edella mainittujen raportointimenetelmien lisaksi analyysista on mahdollista luoda
taulukoita, joihin sisallytetaan erilaisia tietosarakkeita. Taulukkoyhteenvetotyokalu
avautuu Tools -> Summary:Table polkua pitkin. Luotavalle yhteenvetotaulukolle maa-
ritetaan taulukossa esitettavat sarakkeet Properties-valilehdella. Taulukko muodoste-
taan Table-valilehdelle Properties-valilehdella maaritettyjen ominaisuuksien mukai-

toiminnon avulla.
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